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SEGMENTR PRO is a stand-alone utility for creating “virtual segments” as metadata - stored within a
single MPEG-2 (Program Stream), MP4 (H.264) file - or for saving marked segments as multiple,
individual files.
It includes the SEGMENTR PRO FileRx utility, a great ‘prescription’ for file optimization that automatically
repairs and regenerates the structure of your digital files (15 different file types) by automatically
processing them in a Watch Folder, and then outputting them as healthy files (MPEG-2 or H.264) for
reliable server playback.
FileRx also applies 'intelligent' audio limiting, compression and normalization, resulting in files that are
Calm Act compliant with uniform audio levels, setting appropriate LKFS levels with True Peak limiting.

The SEGMENTR User Interface
When no file is open in SEGMENTR PRO, the screen looks like this.
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Summary of the interface and button functions
After installation, double-click on the SEGMENTR desktop icon to open
the application. Then click the OPEN FILE button to open a browse
window on your computer. The supported file types are indicated below
the button. The applications will always ‘remember’ the last location you
browsed to when selecting a file to open.
When you’ve completed segmenting a file, click EMBED SEG DATA to add the segment
information as METADATA to the end of the file. This information is part of the file, so it
‘travels’ wherever the file goes, and with any copies made. This is often called “nondestructive” editing because it leaves the original file intact, just adding segment data to
the file.
If you want to create individual files based on the segments you’ve identified, click
CREATE FILES. You’ll see a window asking you to confirm that you want to create
NEW, SEPARATE FILES for each of the segments. If you click OK, you’ll see a browser
window open to place where the original file is located. You can Save the individual files
to the same folder, or create a New Folder into which you can save the individual files.
In either case the new files will have the same name as the original file, but with a
segment number at the end and before the extension, e.g. “Sports Sunday-01.mpg,
Sports Sunday -02.mpg”, etc.
Click CREATE SEG LIST to generate a text file that contains the names and time codes
of all the individual segments defined in the metadata embedded in the file.

The program has UNDO and REDO functions for every change made while the current
file is loaded.
After the installation, the first time
click the FileRx button you will be
presented with options on where
want to place the five requisite
processing folders (see the
SEGMENTR PRO INSTALLATION
GUIDE for a step-by-step
procedure.) If FileRx is already running in the
system tray, clicking the button will display the
processing log window to view current activity.

you
you

The AUTO SEGMENT button is used primarily with files from Extreme Reach/Pathfire and
Pitch Blue to detect areas within a single file with black video and no audio, then create
segments from active video sections.

Running in Demo Mode
You can run the installer on as many systems as you wish and run in Demo mode to try out the
segmenting and file processing features. The two limitations on Demo Mode are:
1) You have one hour of run-time on SEGMENTR PRO.
2) You can process five (5) files with FileRx.
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The demo period is good for FIVE DAYS from the date of installation. You can purchase the license key
through PayPal, or contact RUSHWORKS for alternate payment methods. A license key is only valid on
ONE computer.
Following is a representation of the User Interface when a file is Open, with one segment “marked” but
with no segments added. Notice that the ADD button is yellow, indicating a newly marked segment.

Here is a description of the timeline controls and functions.

This is the timeline bar with video thumbnail frame display above it. The slider is ‘parked’ at the first
frame of the clip. Left-click and hold the mouse down to ‘scrub’ through the video. Note: You will only

hear audio at normal Play speeds.

The motion controls are used by left-clicking buttons with the mouse, or by using many keyboard
shortcut keys that can make extended segmenting sessions a lot quicker and easier. The ‘interval jump’
buttons (+:01, +:30 etc.) are just shortcuts to let you move forward and backward on the timeline.
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For those who like to work with an external controlling device, we’ve optimized our interface for use with
the Contour ShuttleXpress USB controller. It keeps all the most active functions under one hand for
speed and efficiency when you’re doing a lot of segmenting. It’s readily available from many on-line
retailers for about $60. (See the Installation Notes at the end of this document.)

To create a segment: Use any combination of the slider, the play buttons or USB device
to place the timeline cursor where you want to Mark the IN point. Then click the [IN button.
You can also use the shortcut key I to mark the IN point.
Use the motion controls to find where you want to Mark your OUT point, then click the OUT]
button. You can also use the shortcut key O to mark the OUT point.
To jump to the IN or OUT segment markers, click these buttons, or use the shortcut
keys Q (IN) and W (OUT)
Below is an illustration of what the timeline looks like after you’ve Marked an IN and OUT point. There
are two markers representing the duration between the Marks. The SEGMENT IN, DURATION and
SEGMENT OUT fields display the respective times.
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NOTE: As soon as you create either an IN or OUT mark, the [ADD] Segment
button turns yellow, indicating a mark position has been created. It will remain in
that state until you click it, which adds that segment to the segment inventory list
above. To add the segment to the segment list, click the [ADD] button.

After you ADD the segment to the inventory you’ll notice these graphic changes:
1)
2)
3)
4)

the
the
the
the

[ADD] button returns to its ‘unmarked’ state
Segment number with In and Out points and Duration appears in the inventory list on the right
EMBED SEG DATA button on the left margin is highlighted yellow
Segment now appears in green on the timeline
NOTE: Segment information is NOT saved … or added as metadata to the file … unless
and until you click the highlighted EMBED SEG DATA button. You can continue working
without clicking the button, but if for any reason your session is interrupted or there is a
computer error then the data will not have been saved. So it’s a good item to click it
often, even if you intend to CREATE individual FILES from your segments.
Continue marking and adding segments using the same procedures. As you add
segments, they accumulate in the segment window. Once that window is full of
segments, a scroll bar appears as additional segments are added. Use this for movement
up and down in the segment list.
When you single-click on any of these segments in the list, they highlight – as shown
here – and that segment becomes selected on the timeline. The [ADD] button name
also changes to [UPDATE]. You can then play that segment, edit the In/Out points, or
even delete it by clicking the [DELETE] button at the bottom of the segment window.

If you change the In or Out point of the selected segment, the [UPDATE] button will
turn yellow. Click it to update the segment information. If you decide not to update the
segment, just click the UNDO button on the left of the screen. If you delete Segment 3 out of 8
segments, the remaining segments 4-8 will automatically be renumbered as 3-7.
The TOTAL SEGMENT DURATION is always displayed in yellow at the bottom, and updated as you
ADD, UPDATE or DELETE segments.

To AUTO SEGMENT a file from Extreme Reach/Pathfire or Pitch Blue
These files have sections of black video and no audio that separate areas of
video you want to identify as segments. Click the AUTO SEGMENT button,
and the Processing File progress window will appear. After a few moments
the segments will automatically appear on the timeline and be added to the
segment inventory. You can then click on each segment in the inventory list
and trim and UPDATE segment information as/if needed.
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NOTE: These are typically Transport Stream files which should first be placed
in the FileRx WATCH folder for conversion to MPEG-2 or H.264 prior to
Auto Segmenting. When doing so, be SURE the Compress/Expand audio
box is UNCHECKED to assure proper Auto Segment creation.
If you click the CREATE SEG LIST button, it will open a Save dialog that lets
you determine where you want to save the file, which is formatted as shown below. It includes file
parameters in the first nine lines.

Using SEGMENTR PRO is fast and simple. It should just take a few minutes to create your own rhythm
in opening and segmenting your clips.
Here are the available Menu items in SEGMENTR PRO. If you need assistance with using any of the
items, please contact RUSHWORKS Support at 888.894.7874, option 2.
File is is the most often used Menu.
Primarily you’ll use this to save “virtual
segments’ (with Metadata) or as individual
files for each segment you’ve saved in the
list.
It’s also a convenient way to remove ALL the
saved segments (Metadata) from an open
file

Under the Edit Menu click Preferences to
open that sub-menu.
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On the General Parameters tab, use these
checkboxes to support the style of display
you prefer on your editing User Interface.
They are both UNCHECKED as the default.
The Playback Devices settings only affect
the User Interface monitor, not the output
file.
Deinterlace ON averages two fields into
one frame, which is generally preferred since
it reduces the “jaggies” associated with an
image when it is paused.
Use Video Card YUV Acceleration takes
advantage of your video card for quicker
video screen refresh.
You can choose a different Video Driver if
your display is acting strangely. This will all
depend on the video drivers installation on
your computer.
On the Start Up tab, use the Browse for
Folder button to open a Select Folder dialog
that lets you choose the path to the folder
you create in the initial setup of SEGMENTR
PRO.
You can also check the box if you want to
store your Log files by the date they are
created.

The Segment menu items can be selected,
although the keyboard shortcuts – indicated
on the right – are much quicker and more
efficient during editing.
The Go To In and Go To Out refer to the
corresponding marks on a segment, not the
beginning and ending of the currently loaded
file. If there are no marked segments, the In
and Out will go to the file start and end.

The Time Code Input panel lets you enter a
specific timecode to ‘jump’ to that exact
frame in the file.
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In the Tools menu, select QuickFix to run a
routine that locates bad time stamps and
other typical defects that can often be
corrected using this process. If you receive a
warning message about a problematic file
when you load it, select the QuickFix option.

When you select Show Video Program Info,
this display appears. It shows a lot of file
metadata, which can be helpful when
troubleshooting problematic or unsupported
file types.

In the View menu, when Show/Hide
Thumbnails is checked, you’ll see individual
frame representations above the timeline.

When unchecked, those disappear, and you
see only the current position of the cursor as
a full frame image.
Select Display Closed Captions if you want to
monitor them while you’re segmenting.
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Under the Help menu, the first item is Enter
License key for not yet activated systems.
After you’ve entered the License key and
clicked Activate, this item doesn’t display.
Show User Guide opens a PDF of the entire
Guide.
Show Keyboard Shortcuts opens a PDF of all
the available keyboard shortcuts.
About SEGMENTR PRO displays the Version
number, which is helpful when working with
Support on any issues.

If you’ve already activated the software and you click
Buy SegmentR Now, you’ll see this notification:

If you’re running in Trial Mode and click this item, you’ll
see the PayPal purchasing dialog.
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Keyboard Shortcuts
Home
End
J
K
Space Bar
L
I
O
Q
W
Shift + >
Shift + <
Enter

Go to Clip Start
Go to Clip End
Increment Reverse
Play/Pause
Play/Pause
Increment Forward
Mark In
Mark Out
Go To Segment In
Go To Segment Out
Next Segment
Previous Segment
Save Segment

Up Arrow
Down Arrow
Right Arrow
Ctrl + Right Arrow
Shift + Ctrl + Right Arrow
Shift + Ctrl + Alt + Right Arrow
Left Arrow
Ctrl + Left Arrow
Shift + Ctrl + Left Arrow
Shift + Ctrl + Alt + Left Arrow

Go To In
Go To Out
Single Frame FWD
+:01
+:30
+2:00
Single Frame REV
-:01
-:30
-2:00

USING THE J / K / L INCREMENTAL MOTION KEYS
The L and J keys respond incrementally to keystrokes. Example: if you open an clip and press the L key
once, it starts playing forward at half speed. If you press it again, the file plays forward at 2x speed.
Press it again and it plays at 3x speed. There are SIX intervals, with speed increasing with each press of
the L key.
The same is true for the J key when pressing that increment reverse motion key. If you have pressed L a
few times … then start pressing the J key, you’ll see the forward speed decrement, or slow down, with
each keystroke. Continued J keystrokes will start playing the file in reverse, incrementing across the six
speed intervals in reverse. Click the K key … or space bar … to pause playback. Using the L or J keys you
will then start moving forward or backward from the slowest speed to the highest in the respective
direction.
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Introduction and use of the SEGMENTR PRO FileRx processing utility
If you’ve adopted a file-based workflow, there is a good likelihood that you’ve encountered problems with
some files: unreliable quality, audio level disparity and inconsistent server playback. These anomalies
typically result from two specific file creation processes: files ripped from DVDs (VOB files) and files that
have been output from non-linear editing systems.
The FileRx utility has been designed to quickly and easily restore the health of your files to a consistent
and editable quality. You simply drop files into a processing folder called the Watch folder. Once inside,
FileRx applies 'intelligent' limiting, compression and normalization, resulting in 'healthy' files that have
uniform audio levels as well as a repaired and regenerated file structure for reliable playback.

How does it work?
FileRx automatically repairs and regenerates your digital file structure by examining the program stream
and conforming it to the proper standards. Most time-code errors, packet structure problems, lip sync
offsets (if not created in the original file) and file splits will be detected and corrected.
FileRx provides the user with several setup variables to manage several parameters of the file structure.
Each of these can be set individually, adjusted or disabled.

GETTING STARTED
FileRx is a WORKFLOW SOLUTION ... so there is no traditional "User Interface".
By creating a WORKFLOW whereby you drag and drop ALL your video files (including VOB files ripped
from DVDs) into the FileRx Watch folder, you should achieve a significantly improved level of consistency
and reliability in your server playback.

Working with FileRx
The first time you click the FileRx button on the SEGMENTR PRO interface,
you’ll be presented with a dialog that asks where you want to install the five folders required for the
processing workflow. If SEGMENTR PRO isn’t already open, double-click the SEGMENTR PRO icon on the
desktop to launch the program. When you click once on the FileRx button on the bottom left of the
interface screen, it will display the Event Log processing window.
The FileRx utility logo (RX) is displayed in the system
tray which indicates it’s running in the background.
Depending on your setup, it may also be visible in the
hidden icons popup. To quit the program, right-click the RX icon and choose Exit.
FileRx maintains an Event Log that constantly monitors all of the application's actions and processes.
The Event Log displays how many files are in the queue for
processing, and you’ll see a green progress bar as each file is being
processed. If there is no current activity, you can click the Clear Log
button to remove previous messages from the screen. All data is
preserved in a text file in the LOGS folder.
You can size this window both horizontally and vertically.
As you add files to the Watch folder, FileRx will report each one as
they enter the processing queue. When the file has finished copying,
FileRx will process the file according to the settings under the
Options>System Configuration tab.
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FileRx Application Settings
Every time you open the FileRx utility you will
see the Event Log. This window monitors the
Watch folder and displays the items placed
into the processing queue, as well as their
completion status. There is also an Options
button that opens another window; a Clear
Log button that removes all currently displayed
information in the Event Log window; and a
green progress bar that indicates the status of
the file that is currently processing.
In the lower right hand corner of the Event
Log there is an Options button. Pressing this
button opens the Options window that
contains the default/user-defined settings for
clip management. More detailed description of
the Options settings follow.

Switching between SEGMENTR and FileRx screens
SEGMENTR PRO editing and FileRx processing run as two separate, independent applications on
your computer. This enables you to do FileRx processing while you are segmenting files. But because
FileRx processing requires a lot of CPU power – especially when you are transcoding from one format
to another – it can affect performance if you’re simultaneously segmenting.
When you close the Event Log window by clicking the (X) in the upper right hand corner, FileRx
continues to run in the background, minimized to the System Tray. It continues to process any files
that are placed into and/or currently queued in the Watch folder.
To exit the application, locate the FileRx icon in the System Tray or hidden icons
popup menu on the bottom right of your screen, right-click the icon and select Exit
from the menu.

Remember: when you exit the application, files in the Watch folder will not be processed until the
program is restarted.
In the bottom right of the main FileRx Event Log you will find the Options button. Clicking this button
will take you to the Options page where you can configure and/or review FileRx options.
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The System Configuration Tab
The first tab you will see under Options is the
System Configuration Tab. This is where you
control the processing features of FileRx.
The check boxes Compress/Expand audio is
checked by default, which leave the video
untouched but apply the audio compander
for consistent levels in all the processed files.
Notice that the Video Properties box is
unchecked, and the associated options are
grayed out and not selectable.
At the bottom of the
tab you can specify
Process priority
(Normal/Low). Low
priority “throttles” the
CPU so that it doesn’t use all the system
computing power for processing.
IMPORTANT: If you want to run FileRx in the
background on a system running RUSHWORKS
A-LIST Broadcast Automation, the Process
priority MUST be set to Low (Default).
Otherwise the automation performance will
suffer due to lack of CPU availability.
You can also click the Restore Defaults to
overwrite any values you’ve set in the multiple
dropdown windows.

The Output File Type dropdown lets you
choose between the two available file types:
MPEG-2 and H.264.

In the Audio Properties section are pull
downs for Audio bitrate, Normalization level,
and Audio sampling rate.
The Audio bitrate default is 224 kbps.
The Normalization level default is -12dB.
The Audio sampling rate default is 48KHz.

Note: if you are using A-LIST Broadcast
Automation, you can NOT play an H.264 file
with 44.1KHz audio.
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In the Video Properties section are various
pull down menus that let you customize the
parameters for transcoding your videos.
The Transcode video check box, which
defaults to unchecked, disables transcoding
the video if you wish to leave the video portion
of your files untouched, and focus on
optimizing just the audio portion of the files.
When unchecked, the five options are grayed
out.
If checked, you have several options to choose
from when transcoding.
Video bitrate
This setting determines the bitrate of the file
you are sending to the Output folder after
processing.

File structure
Your choices are VBR (Variable Bit Rate) and
CBR (Constant Bit Rate). VBR files are typically
smaller but with higher overall quality than
CBR by the nature of the encoding algorithm.
GOP structure
GOP is an acronym for Group Of Pictures. This
setting determines how many key frames are
used when creating interim interpolated
frames during MPEG processing. 15 is the
most typical.
The Archive File Deletion section allows you
to specify how long your old files will stay in
the Archive folder before being deleted. These
are the original files placed in the Watch
folder.
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The Folders Tab
SEGMENTR PRO installs five folders that are
used to organize your files for the FileRx
processing workflow. These folders are
automatically set up as your defaults for storage
of files used by the application. See the
SEGMENTR PRO INSTALLATION GUIDE for
details.

Watch Folder
Any files to be processed should be dropped into
the WATCH folder. The software automatically
scans the folder for new entries and keeps a list
of what files have been placed in this folder.
FileRx will wait until the entire file is copied to
the folder before it begins processing.

Output Folder
All successfully processed media will be moved
to the Output folder. Anything FileRx places in
this folder will be ready for airing based on your
settings specified in the System Configuration
tab.

Archive Folder
Files that have been processed through FileRx
will be moved to the Archive folder. The files will
remain here until they are deleted according to
the rules that have been set in the System
Configuration tab. The default setting before
deletion is three weeks from processed date.

Error Folder
If for any reason the application is not able to
process a file in the Watch Folder, it will
automatically move that file to the Error Folder.
In some cases, putting it back into the Watch
Folder may have successful results on a second
pass. Otherwise the file may be too damaged, or
formatted such that it cannot be processed.

Log Folder
As FileRx processes files it will log events to a
text file located inside the Log Folder. If you wish
to verify a certain file processed in a large batch,
or find more details about an error that occurred
- the Log Folder is the place to look.

PROCESSING FILES
FileRx is capable of processing files produced by many different codecs, repairing and regenerating them
for successful playback on most video servers.
However, it is possible that some files have been damaged or are otherwise corrupt, and can NOT be
successfully processed due to these conditions. These situations should be rare, depending on your
source(s) for files.
NOTE: In some cases, if a file fails to process and is placed in the Archive folder, you might try dragging
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it into the WATCH folder again. It may successfully process with a second attempt.

Batch Processing Files
Once your folders are set up under the Folders Tab of the Options Screen, you are ready to start
processing files. To begin, simply drag and drop your files into the WATCH folder and FileRx will begin to
process.
Things to remember:
1. FileRx will process every file according to the settings you have selected in the System
Configuration Tab. If a group of files are being processed and you wish to adjust the settings, the new
settings will affect the next file processed. If one file in a "batch list" is being processed, new settings will
NOT take effect during the processing of that file. The new settings will affect subsequent files in the list.
2. If you want to process your entire library of files, it is recommended that you reserve a large amount
of disk space for doing so. During processing FileRx creates new, optimized files and puts them in the
designated Output folder. The originals are then moved to the Archive folder. It is a good idea to verify
the new file before deleting the original file. The original files will remain in the Archive folder according
to the rules you have specified in the Archive File Deletion section of the System Configuration
Tab.

Processing a DVD
Option 1: Process an entire DVD
FileRx has an auto-naming feature for DVD processing. To take advantage of this feature:
1) Place a Video DVD* in the appropriate DVD drive.
2) Within FileRx WATCH folder, create a NEW folder and name it what you would like the final processed
file to be named.
3) Copy the entire VideoTS folder (or the contents of that folder) into the NEW folder you created inside
the Watch folder. Once the files have copied completely, FileRx will begin processing the folder.

Option 2: Process a single file from a DVD
If you want to process a single VOB file which is not part of a DVD structure, then you will need to
rename the file from the DVD naming convention format, e.g. VTS_XX_X.VOB, to something like
myfile.vob so that it will be recognized by the auto-parser.
* If you are using a Data DVD ... simply drag the MPEG-2 or VOB files into the Watch Folder
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Glossary
The following are common terms associated with SEGMENTR PRO with FileRx.
Aspect Ratio
The ratio of the width of the video to the height of the video. The two main aspect ratios for video are
4x3 and 16x9.
Bit Rate
The number of bits of data sampled per second of video or audio, usually larger numbers means better
quality.
CBR
Constant Bit Rate - A file of this type will have the same number of bits sampled every second, and is not
dependent on the complexity of the image or sound.
Compander
A contraction of the words ‘compressor’ and ‘expander’. This dual-pass function is unique to FileRx, which
senses if the audio level needs to be raised to a higher, uniform output level … or be lowered to eliminate
transient level spikes and create a uniform output level.
Compressor (Audio Compression)
A device (or software) that reduces the dynamic range of audio.
DVD
A 5.25 inch reflective disk containing video, audio or data.
File Structure
Normally refers to the structure of the video or audio file on a disk, CBR or VBR being the choices.
GOP
Group of Pictures - GOPs can vary in length and structure and can contain various frame types.
Limit (Audio Limiter)
A limiter established a maximum gain setting and prevents the audio signal from getting any louder than
that setting.
MPEG
Motion Picture Experts Group - Currently defined are specs for MPEG 1, 2, 3 and 4. Each file has its own
purpose, SEGMENTR PRO FileRx currently works with MPEG-2 files.
Normalize
This is a process which increases (or decreases) the gain of an audio file until its loudest point is at the
maximum level set by the user.
Rip (Rip a DVD)
Copy the files from a DVD onto a hard disk.
Sampling Rate
The frequency of which a digital sample of video or audio information is taken from an analog wave.
VBR / Variable Bit Rate
A file of this type will have varying sizes sampled each second, based on the complexity of the image or
sound
VOB / Video Object
A container for MPEG-2 program streams used with DVD-Videos.

****************************
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Contour ShuttleXpress Installation
The INSTALLATION FILES can be downloaded from the SegmentR PRO page on the
RUSHWORKS website.
1. Install the driver "cdi_shuttle_win_2.13.3.exe" & reboot the computer.
2. Go to the Task bar and click on the Hidden up-arrow (by the clock in the system tray on the lower
right), left-click the ShuttleXpress icon, and select Open Control Panel.

3. In the Control Panel dialog click on Options. Select the Import Settings window, locate and select
the SegmentR.pref file and click Apply.

These procedures should configure the ShuttleXpress for use with the SEGMENTR PRO User Interface.
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For technical support contact:
support@RUSHWORKS.tv
888.894.7874 Ext 2

SEGMENTR PRO™ with FileRx™ is a RUSHWORKS Software Innovation
©2001-2020 All Rights Reserved
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